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About This Guide

The Calibration Kit is the calibration environment that is part of Synopsys Sentaurus™
Workbench Advanced. The Calibration Kit is the interface to the calibration libraries and
calibration files.

Related Publications

For additional information, see:

■ The documentation installed with the Calibration Kit software package and available from
the Help menu of the Calibration Kit.

■ The TCAD Sentaurus release notes, available on the Synopsys SolvNet® support site (see
Accessing SolvNet on page vi).

■ Documentation available on SolvNet at https://solvnet.synopsys.com/DocsOnWeb.

Conventions

The following conventions are used in Synopsys documentation. 

Customer Support

Customer support is available through the Synopsys SolvNet customer support website and by
contacting the Synopsys support center.

Convention Description

Blue text Identifies a cross-reference (only on the screen).

Bold text Identifies a selectable icon, button, menu, or tab. It also indicates the name of a field or an 
option.

Courier font Identifies text that is displayed on the screen or that the user must type. It identifies the 
names of files, directories, paths, parameters, keywords, and variables.

Italicized text Used for emphasis, the titles of books and journals, and non-English words. It also 
identifies components of an equation or a formula, a placeholder, or an identifier.

Menu > Command Indicates a menu command, for example, File > New (from the File menu, select New).
Calibration Kit User Guide v
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About This Guide 
Customer Support
Accessing SolvNet

The SolvNet support site includes an electronic knowledge base of technical articles and
answers to frequently asked questions about Synopsys tools. The site also gives you access to
a wide range of Synopsys online services, which include downloading software, viewing
documentation, and entering a call to the Support Center.

To access the SolvNet site:

1. Go to the web page at https://solvnet.synopsys.com.

2. If prompted, enter your user name and password. (If you do not have a Synopsys user name
and password, follow the instructions to register.)

If you need help using the site, click Help on the menu bar.

Contacting Synopsys Support

If you have problems, questions, or suggestions, you can contact Synopsys support in the
following ways:

■ Go to the Synopsys Global Support Centers site on synopsys.com. There you can find e-
mail addresses and telephone numbers for Synopsys support centers throughout the world.

■ Go to either the Synopsys SolvNet site or the Synopsys Global Support Centers site and
open a case online (Synopsys user name and password required).

Contacting Your Local TCAD Support Team Directly

Send an e-mail message to:

■ support-tcad-us@synopsys.com from within North America and South America.

■ support-tcad-eu@synopsys.com from within Europe.

■ support-tcad-ap@synopsys.com from within Asia Pacific (China, Taiwan, Singapore,
Malaysia, India, Australia).

■ support-tcad-kr@synopsys.com from Korea.

■ support-tcad-jp@synopsys.com from Japan.
vi Calibration Kit User Guide
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CHAPTER 1 Introduction to the Calibration Kit

This chapter presents an overview of the Calibration Kit.

Functionality of the Calibration Kit

The Calibration Kit extends the functionality of Sentaurus Workbench, assisting you to
perform efficient 1D calibrations of the Synopsys process simulators Sentaurus Process and
Sentaurus Process Kinetic Monte Carlo.

Sentaurus Workbench is the primary graphical front end of TCAD Sentaurus that integrates the
simulation tools into one environment (see the Sentaurus™ Workbench User Guide). The
Sentaurus Workbench Advanced mode provides customized viewers and wizards for
calibration. The Calibration menu of Sentaurus Workbench provides wizards for the
manipulation of the simulation flow and report generation (see Chapter 2 on page 9).

In combination with the calibration libraries containing secondary ion mass spectrometry
(SIMS) data, the Calibration Kit provides a fast, accurate, and reliable method of evaluating
and optimizing process conditions. It allows a predictive analysis of the influence of process
equipment parameters on electrical device data. In addition, the Calibration Kit helps you to
understand the sensitivity of processes to various control parameters, enabling you to optimize
equipment operation quickly.

The Calibration Kit is the calibration environment in Sentaurus Workbench Advanced. It
serves as a database browser, and a simulation and project manager.

The software package Optimizer, which is integrated in Sentaurus Workbench Advanced, is
used for the automatic analysis and optimization of process and calibration parameters (see the
Optimizer User Guide).

In addition to the analytic extraction in the process simulators, Sentaurus Device can be
integrated for electrical parameter extraction, preceded by Sentaurus Mesh for mesh
generation.

For visualization, Inspect and Sentaurus Visual are integrated into the Calibration Kit.
Calibration Kit User Guide 1
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1: Introduction to the Calibration Kit 
Input Modules
Input Modules

Process descriptions and data, which are calibration libraries such as the Calibration Library,
as well as simulator calibration files such as Advanced Calibration are used as input to the
Calibration Kit.

Calibration Libraries

The calibration libraries are experiment databases consisting of the following directories:

■ processes_* 

■ experiments 

■ preferences 

You can add your own experimental data to the measurement database or create your own
database. In the latter case, it is recommended to keep the same directory structure, with
process files, profile files, and preference files in three directories (see Defining the Calibration
Library on page 29).

The process recipes can use Ligament SPR syntax or Sentaurus Process syntax, with specific
restrictions for the Calibration Kit (see Process File Syntax on page 29). The directory
experiments can contain SIMS profiles and spreading resistance profiles.

Process Directory

In the process directory processes_*, each process file contains a recipe for wafer processing
and a reference to the corresponding SIMS measurements. By default, these recipes are written
in the simple process representation (SPR) syntax of Ligament and do not contain any
simulator models or parameters. In this case, the directory is called processes_lig.

The file name of the process is the same as the name of the process. The input files of Sentaurus
Process are created automatically before simulation by translating Ligament SPR syntax to
Sentaurus Process syntax, and by calibrating the pure recipes with simulation models. For
Sentaurus Process, the calibration parameters and models are sourced before a process recipe
is applied.

In the process files, the SIMS measurements are represented by insert statements. The
insert statement is translated to the Calibration Kit–specific SetPltList statement for
Sentaurus Process. In each SetPltList statement, the measured chemical dopant species and
the file name of the SIMS profile are specified. A process file can have several SetPltList
statements, which correspond to several SIMS profiles.
2 Calibration Kit User Guide
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1: Introduction to the Calibration Kit
Input Modules
In a Sentaurus Workbench project generated by the Calibration Kit, the file names of the
process flows are changed to b@node@_fps.cmd, where @node@ is the number of a project
node of Sentaurus Workbench. For details, see Structure of Calibration Kit Projects on page 5.

Experiment Directory

The experiment directory experiments contains the measured SIMS profiles in xy format.
The first column is the depth [nm] and the second column is the concentration of the chemical
dopant [ ]. The file names match exactly the names specified in the 1D commands of the
recipe files.

In a Sentaurus Workbench project generated by the Calibration Kit, the SIMS profiles are
named b@node@_[profile].plx, where @node@ is the number of a project node of
Sentaurus Workbench. For details, see Structure of Calibration Kit Projects on page 5.

Preference Directory

The preference directory preferences contains additional information. For each SIMS
profile name.sims in the experiments directory, there is one preference file
name_sims.prf in the preferences directory that specifies the following (Tcl) variables:

■ sims_xmin and sims_xmax give the depth [nm] range for which the SIMS profile should
be compared to the simulation results.

■ vis_xmin and vis_xmax are the preferred minimal depth [nm] and maximal depth [nm],
respectively, to be shown in a graphical representation of the profile.

■ vis_ymin and vis_ymax are the preferred minimal concentration [ ] and maximal
concentration [ ], respectively, to be shown in a graphical representation of the profile.

■ probe_xmax gives the depth [nm] of the contact for device simulation to calculate the
sheet resistance.

In a Sentaurus Workbench project generated by the Calibration Kit, all preference files are
named b@node@_[profile].prf, where @node@ is the number of a project node of
Sentaurus Workbench. For details, see Structure of Calibration Kit Projects on page 5.

Calibration Files

The directory $STROOT/tcad/$STRELEASE/lib/fabpackagelib contains calibration
(text) files with physical models and parameters for Sentaurus Process and Sentaurus Process
Kinetic Monte Carlo.

cm 3–

cm 3–

cm 3–
Calibration Kit User Guide 3
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1: Introduction to the Calibration Kit 
Input Modules
Advanced Calibration for Sentaurus Process

Two files in the fabpackagelib directory are used for calibrated 1D simulations of Sentaurus
Process with the Calibration Kit: AdvCal_2017.09.fps and calib_1d_2017.09.fps.

The file AdvCal_2017.09.fps is the latest version of Advanced Calibration for Sentaurus
Process. It contains a selection of physical models and parameters that are calibrated for deep-
submicron technology. This file is identical to the AdvCal_2017.09.fps file in the directory
$STROOT/tcad/$STRELEASE/lib/sprocess/TclLib/AdvCal.

NOTE When improvements to the model calibration are made, between feature
releases, the file in the fabpackagelib directory will contain the latest
version. The contents of the AdvCal_2017.09.fps file are explained
in the Advanced Calibration for Process Simulation User Guide, which
can be accessed from Sentaurus Workbench (Help > Manuals).

The file calib_1d_2017.09.fps contains information needed for simulations, which does
not belong to the process flow or the physical models, and includes:

■ The creation of a 1D simulation mesh, which is optimized for accurate 1D simulations.

■ A procedure (WritePlt) definition for writing 1D profiles in .plt format.

■ A procedure (OxideThickness) definition for extracting the cap-oxide thickness.

■ A selection of meshing parameters.

The last lines of the calib_1d_2017.09.fps file create a 1D mesh and source the file
AdvCal_2017.09.fps, which contains the physical models.

NOTE Older versions of the calibration files are available in the directory
$STROOT/tcad/$STRELEASE/lib/fabpackagelib and can be
used with the latest release of Sentaurus Process.

Advanced Calibration for Sentaurus Process Kinetic Monte Carlo

Two files in the fabpackagelib directory are used for calibrated pseudo-1D simulations of
Sentaurus Process Kinetic Monte Carlo (Sentaurus Process KMC) with the Calibration Kit:
AdvCal_KMC_2017.09.fps and calib_KMC_2017.09.fps.

The file AdvCal_KMC_2017.09.fps is the latest version of Advanced Calibration for
Sentaurus Process KMC. It contains a selection of physical models and parameters that are
calibrated for deep-submicron technology. This file is identical to the
AdvCal_KMC_2017.09.fps file in the directory $STROOT/tcad/$STRELEASE/lib/
sprocess/TclLib/AdvCal.
4 Calibration Kit User Guide
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1: Introduction to the Calibration Kit
Structure of Calibration Kit Projects
The file calib_KMC_2017.09.fps contains information needed for simulations, which does
not belong to the process flow or the physical models, and includes:

■ The creation of a 3D atomistic simulation cell and a 1D projection mesh, which is
optimized for accurate pseudo-1D simulations.

■ A procedure (WritePlt) definition for writing 1D profiles in .plt format and for logging
the thickness of the amorphous layer.

■ A selection of recording options for atomistic data.

■ A selection of atomistic parameters.

The last lines of the calib_KMC_2017.09.fps file create the simulation cell, select the
atomistic mode, and source the file AdvCal_KMC_2017.09.fps, which contains the physical
models.

Structure of Calibration Kit Projects

A Calibration Kit project is a special type of Sentaurus Workbench project with either three or
five tools, and one to seven parameters. For details about Sentaurus Workbench and its general
project structure, see the Sentaurus™ Workbench User Guide.

Figure 1 shows an example of a Calibration Kit project. The first tool instance in the tool flow
is Sentaurus Process for process simulation. Optionally, a Sentaurus Mesh tool instance can be
used for mesh generation and a Sentaurus Device tool instance can be used for device
simulation. The Inspect tool instance for variable value extraction is followed by Sentaurus
Visual for visualization. 

Figure 1 Calibration Kit project loaded in Sentaurus Workbench; tool flow is horizontal and 
experiment flow is vertical
Calibration Kit User Guide 5
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1: Introduction to the Calibration Kit 
Structure of Calibration Kit Projects
The parameter nr of Sentaurus Process represents the index of the process. Each experiment
has a unique process recipe. The process file-naming convention is b@nr@_fps.cmd for
Sentaurus Process. In general, files starting with b@nr@_* belong to the experiment of the
parameter value @nr@.

The Calibration Kit uses different Sentaurus Workbench variables:

■ process names the process recipe.

■ process_info lists process information.

■ n_profile shows the number of profiles per experiment, which are named by the
variables profile_@integer@, where integer is equal to 1, 2, 3, …, 10.

For each profile, the file b@nr@_@{profile_@integer@}@.plx contains the
experiment data, and the file b@nr@_@{profile_@integer@}@.prf contains the
preferences.

To identify a Sentaurus Workbench project as a Calibration Kit project, an empty hidden
file .fabpackage is included in the project directory. The greadme.txt file (Project >
Readme) can be used to collect project information.

Sentaurus Process

The project structure is the same for Sentaurus Process in continuum mode or in kinetic Monte
Carlo mode. The mode is defined in the calibration files.

Sentaurus Process uses the command file n@node@_fps.cmd as input. This command file
sources the calibration file @calibration@ of Sentaurus Process, evaluates the parameter nr
for each experiment, and sources the process recipe b@nr@_fps.cmd. Therefore, the
parameter nr of Sentaurus Process represents the process.

The output of the Sentaurus Process tool instance is the following files:

■ b@nr@_@{profile_@integer@}@_simulation.plt (xy plot file)

■ b@nr@_fps.tdr (TDR file)

■ b@nr@_bnd.tdr (TDR boundary file)

Therefore, the file name of the simulated profile (the xy plot file
b@nr@_@{profile_@integer@}@_simulation.plt) differs only from the file name of
the measured profile (the b@nr@_@{profile_@integer@}@.plx file) in its file extension.

The Sentaurus Process tool instance defines the variables process, process_info,
calibration, n_profile, and profile_@integer@. Sentaurus Process can have a
second parameter (see Creating a New Parameterized Project on page 17).
6 Calibration Kit User Guide
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1: Introduction to the Calibration Kit
Structure of Calibration Kit Projects
Sentaurus Process is called with the command-line option -n to switch off the syntax check.

Optionally, you can extract the sheet resistance analytically using the Sentaurus Process
command SheetResistance, and the result is transferred to the Sentaurus Workbench
variable Rs_fps.

For Sentaurus Process KMC, you can store the atomistic information using the following
command:

kmc extract tdrWrite

Sentaurus Mesh (Optional)

Sentaurus Mesh is used for the mesh generation of a 2D device simulation. For the calculation
of sheet resistance, a 2D device is defined to represent the sheet of an ultrashallow junction of
a transistor. The device definition is taken from the output files b@nr@_fps.tdr and
b@nr@_bnd.tdr of Sentaurus Process.

The geometry is described by the following variables defined for Sentaurus Mesh:

■ x_sheet defines the length [ ] of the sheet (default is 20 ).

■ y_sheet defines the depth [ ] of the sheet.

■ y0_sheet defines the top position [ ] of the sheet.

■ y_contact defines the depth [ ] of the contacts.

■ y0_contact defines the top position [ ] of the contacts.

The doping and grid information is stored in the n@node@_msh.tdr file.

Sentaurus Device (Optional)

Sentaurus Device performs a 2D device simulation on the sheet defined in the
n@node|mesh@_msh.tdr file. The voltage and the total current distribution of the sheet are
computed for a voltage of 0.01 V between the left and right contacts. The results are saved in
the n@node@_des.plt file. Sentaurus Device uses the default parameters for silicon,
germanium, and SiGe from files by specifying the DefaultParametersFromFile flag in
the global Physics section of the command file. The optional parameter file of Sentaurus
Device is named sdevice.par.

μm μm

μm

μm

μm

μm
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1: Introduction to the Calibration Kit 
Structure of Calibration Kit Projects
Inspect

Inspect calculates the sheet resistance and the curve differences. From the file
n@node|sdevice@_des.plt, Inspect takes the voltage and the total current distribution, and
calculates the sheet resistance. The results are stored in the Sentaurus Workbench variable
Rs_sim. You can compare the extracted value with the experimental data for some
experiments. The variable Rs_exp, which is defined by Sentaurus Process, retains the
measured value or is set to zero if no measurement value is present.

For each profile pair, Inspect computes the difference between the measured profile and the
simulated profile, that is, between b@nr@_@{profile_@integer@}@.plx and
b@nr@_@{profile_@integer@}@_simulation.plt.

Different methodologies are available for this curve comparison (see Comparing Profile
Curves on page 35). The variables cv_delta_@integer@, where integer is equal to 1, 2,
3, …, 10, hold the extracted curve difference per  for profile_@integer@.

You can view the profiles in interactive mode. If you want to save the visualization in the
Inspect format, this must be performed manually.

Optionally, a spline-based curve-smoothing (a smooth, piecewise, polynomial approximation)
is applied to the measured profile or the simulated profile for curve comparison.

See Viewing Profile Files on page 27.

Sentaurus Visual

Sentaurus Visual visualizes all measured and simulated profiles of a process in one xy plot. For
each node, Sentaurus Visual takes all profiles (b@nr@_@{profile_@integer@}@.plx and
b@nr@_@{profile_@integer@}@_simulation.plt), the curve comparison results
(cv_delta_@integer@), and the preferences (b@nr@_@{profile_@integer@}@.prf),
and creates a Sentaurus Visual Tcl script n@node@_vis_out.tcl for customized xy plot
visualization.

All profiles of the experiment are plotted on top of each other. The curve comparison results
cv_delta_@integer@ are listed next to the curve label of the corresponding simulated
profile. The borders of the curve comparison of the last profile pair are drawn in dashed style.

See Viewing Visualization Files on page 27.

μm
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CHAPTER 2 Working With Calibration Kit 
Projects

This chapter describes how to work with Calibration Kit projects.

Manipulating Calibration Kit Projects

A Calibration Kit project can be manipulated like other Sentaurus Workbench projects (for
details about editing projects, see the Sentaurus™ Workbench User Guide). However, you can
use special wizards of the Calibration Kit to guide you through project creation and extension,
scenario and experiment generation, and parameterization.

It is faster and more thorough to manipulate projects using these wizards rather than the
standard features of Sentaurus Workbench. The wizards are available from the Calibration
menu of Sentaurus Workbench.

NOTE The Calibration menu is shown only in Sentaurus Workbench
Advanced mode. 

Figure 2 Wizards available from Calibration menu

NOTE Renumbering nodes of a Calibration Kit project can lead to a reduction
of functionality. It is strongly advised not to renumber nodes.

Creating a New Project or a New Scenario for an Existing 
Project

You can create a new Calibration Kit project or extend an existing project by a new scenario.
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To create a new Calibration Kit project or a new scenario to an existing project:

1. Choose Calibration > Project Wizard.

The Project Wizard opens.

2. Click Next to start.

3. Select the calibration library database from either:

• Calibration Library, which is the experiment database of the Calibration Library in
Ligament SPR syntax.

• User Library, which is a user-specified database in either Ligament SPR syntax or
Sentaurus Process syntax.

If you select this option, you must specify the process directory, the experiment
directory, and the preference directory, and select the syntax from either Ligament,
Sentaurus Process, or TSUPREM-4. 

4. Click Next.
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5. Select a process list in one of the following ways:

• Under DBPS - Database Process Search, type a search pattern in the Process Search
Pattern field to look for processes using the DBPS in the selected database and syntax
(Step 3).

Select the alphabetic order of the process list file from either Process Names or
Process Recipes.

Click the Search button to write the results to the selected process list file (see
Database Process Search on page 32).

• Click the Browse button to select a list or search for a list using the DBPS. (For the
syntax of a process list file file.qps, see Process Searches on page 31.)

Click the Edit button to edit the selected list using the SEdit text editor.

6. Click Next.

7. Select the process simulator and calibration from either:

• Sentaurus Process (default)

If you choose this option, under Calibration, select the implantation model, and select
the diffusion model.

Select either the parameters of Advanced Calibration or User Calibration, in which
case, select up to two calibration files in the Alagator (Tcl) syntax of Sentaurus Process,
which usually follow the naming scheme *.fps.

• TSUPREM-4 

If you choose this option, under Calibration, select the implantation model.

Select either the parameters of Advanced Calibration or User Calibration, in which
case, select the calibration files.

8. Click Next.

9. Select the device simulation to calculate the sheet resistance from one of the following
options:

• Device Simulation Disabled (default)

• Device Simulation Enabled 

If this option is selected, the Sentaurus Mesh and Sentaurus Device tool instances are
part of the project. Click the Browse button to select the parameter file for Sentaurus
Device. The file format usually follows the naming convention *.par and is named
sdevice.par in the project. If no file is selected, Sentaurus Device uses the default
parameters.

10. Click Next.
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11. Select the methodology for the simulation and the experiment profile comparison from the
following options:

For numeric comparison, select one of the following options:

• Relative Logarithmic Square Difference (default)

• Relative Linear Square Difference 

• Arithmetic Mean of Relative Error 

• Quadratic Mean of Relative Error 

The options of the Noise Filter field are deactivated by default. Select the options as
required to activate the noise filter (spline-based curve-smoothing) for experiment data, or
simulation data, or both.

Select the visualization tool. Sentaurus Visual is the default.

12. Click Next.

13. Select a project and scenario name from the following options:

• Select the Create New Project option for a new project.

Type the scenario name, and click the Browse button to select a project directory or
type the project name.

• Select the Add to Project option to add a new scenario to an existing project.

Type the scenario name, and click the Browse button to select a project.

The new experiments will have the same structure as the rest of the project, that is, the
selection of device simulation follows the existing project selection.

14. Click Finish.

15. If the project or scenario is created and loaded successfully, click OK in the Progress dialog
box.

The generated project has the structure of the Calibration Kit described in Structure of
Calibration Kit Projects on page 5. For each process in the process list, the Project Wizard
creates an experiment that follows the file-naming convention of the Calibration Kit. In the case
of a database in Ligament SPR syntax, the process is translated to the syntax of the selected
process simulator (see Process File Syntax on page 29). In the case of a database in Sentaurus
Process syntax, the process is copied; it is not translated. For Sentaurus Process, the resulting
process file is b@nr@_fps.cmd.

The file name of the process sets the variable process. The file names of the profiles set the
variables profile_@integer@.
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The variable process_info takes INFO as a value if processinfo appears as a remark or
comment in the process file. For Ligament, this is:

remark (text : "processinfo 'BF2 2.5keV 1e15'");

For Sentaurus Process, processinfo is:

## processinfo "INFO"

Analogously, the variable Rs_exp is set to VALUE if sheetresistance appears as a remark
or comment in the process file. For Ligament, this is:

remark (text : "sheetresistance 'VALUE'")

or:

remark (text : "sheetresistance 'Rs=VALUE'")

For Sentaurus Process, sheetresistance is:

## sheetresistance "VALUE"

or:

## sheetresistance "Rs=VALUE"

The variable y_sheet is set to 1.25 times the valid depth (set as sims_xmax in the preference
file) of the deepest profile. If no preference (sims_xmax) is present, the default value of 50 nm
is used. In addition, the variable y_contact is set to 0.25 times the valid depth (set as
sims_xmax in the preference file) of the shallowest profile, unless the depth is defined
explicitly (as probe_xmax in the preference file). If no preference (probe_xmax or
sims_xmax) is present, the default value of 5 nm is used.

Defining a New Scenario for a Project

To focus on a specific selection of experiments for a Calibration Kit project, a project can be
split into scenarios. For example, a project can be split into scenarios of different dopant
elements.

To create a new scenario for a Calibration Kit project:

1. Open a Calibration Kit project.

2. Choose Calibration > Scenario Wizard.

The Scenario Wizard opens.

3. Click Next to start.
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4. Under CPPS - Calibration Project Process Search, type a search pattern in the Process
Search Pattern field to select experiments, and click Search (see Calibration Project
Process Search on page 33). 

5. Click Next.

6. Type the name of the new scenario in the Scenario Name field.

7. Click Finish.

8. If the scenario is created and loaded successfully, click OK in the Progress dialog box.

The structure of the Calibration Kit project is unchanged by the creation of a new scenario.

Creating a New Short Loop Experiment

You can add a new short loop experiment (in Ligament SPR syntax or Sentaurus Process
syntax) to a database or add a new experiment to a Calibration Kit project.
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To create a new short loop experiment for a Calibration Kit project:

1. Open a Calibration Kit project.

2. Choose Calibration > Process Wizard. 

The Process Wizard opens.

3. Click Next to start.

4. Select the substrate and oxide properties.

If the oxide thickness is 0, the oxide deposition step is omitted.

5. Click Next.

6. Select the implantation properties of the first and second implantations.

If the Element field is set to 0, the corresponding implantation step is omitted.

7. Click Next.

8. Select the anneal ramp properties.

If the Rate or Time fields are set to 0, the corresponding diffusion step is omitted. 
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9. Click Next.

10. Select the properties for the first and second measurements:

• If the Element field is set to 0, the corresponding measurement step is omitted.

• For the Experiment Data field, click Browse to select the experimental measurement
data (SIMS).

Click View to view the selected SIMS using Inspect.

• Select the depth scale of the selected SIMS.

• For the Preferences field, click Browse to select the preferences.

Click Create to create new preferences and to edit them with the SEdit text editor.

11. Click Next.

12. Select a process name and syntax:

• Type the name of a process in the Name field.

• From the Syntax field, select the required option.

• Click the Edit button to edit the flow if required.

If Ligament SPR syntax is selected, the flow is loaded into the Ligament Flow Editor.
If Sentaurus Process syntax is selected, the flow is loaded into a text editor.

If needed, the flow can be further modified beyond the guidelines of the previous
wizard pages.

When Edit is clicked, the current values of the process steps defined in the previous
steps are considered. Further changes to the process through the previous wizard pages
no longer affect the flow, unless Edit is clicked again.

If Edit is clicked again, the current values of the process steps defined in the previous
wizard steps are reconsidered, and the previous changes of the flow in the editor are
deleted.

13. Click Next.

14. Select whether the process is added to a database or the currently loaded project:

• Select the Add to Project option to add a new experiment with the created process flow
to the currently loaded Calibration Kit project.

This option is available only if the currently loaded project is a Calibration Kit project
and contains the same simulator that was previously selected as the process syntax.

• Select the Add to User Library option to add the process flow permanently to a
database. Select the process directory for the process recipes, the experiment directory
for the measurement data, and the preference directory for the preferences.
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15. Click Finish.

16. If the experiment is created successfully, click OK in the Progress dialog box.

If added to a database, the process recipe is stored in the same format as those in the calibration
libraries (see Process File Syntax on page 29). The process flow includes the correlated profile
and process_info information.

If added to a project, the experiment has the same structure as the other experiments of the
project. The variable process is defined by the process name. If an experiment profile is
referenced, the variable profile_@integer@ is defined by the name of the experiment
profile. If no experiment profile is referenced, the variable profile_@integer@ is defined
by @process-name@_@integer@. Depending on the declared implantation and diffusion
steps, the variable process_info is set.

The variable y_sheet is set to 1.25 times the valid depth (set as sims_xmax in the preference
file) of the deepest profile. If no preference (sims_xmax) is present, the default value of 50 nm
is used. In addition, the variable y_contact is set to 0.25 times the valid depth (set as
sims_xmax in the preference file) of the shallowest profile, unless the depth is defined
explicitly (as probe_xmax in the preference file). If no preference (probe_xmax or
sims_xmax) is present, the default value of 5 nm is used.

NOTE If the process flow is edited further after the wizard generation, you
must ensure that the variable values (such as the number of profiles
n_profile) are correct.

Creating a New Parameterized Project

You can create a new Calibration Kit project with new physical Sentaurus Process parameters,
and an optional command file for the Optimizer tool.

To create a new Calibration Kit project with new physical Sentaurus Process parameters:

1. Open a Calibration Kit project and select an experiment.

2. Choose Calibration > Parameter Wizard.

The Parameter Wizard opens.

3. Click Next to start.

4. Parameterize the selected process (the name and simulator syntax of the selected process
is displayed):

a) Select up to six parameter names for parameter (for example, energy).
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b) Select to either Include or Exclude the experiment data.

If experiment data is included, the experiments of the resulting project contain the
experiment profiles (SIMS) of the selected experiment.

c) Click Edit to load the flow is loaded into an editor.

Edit the flow by replacing the argument values to be parameterized with
@parameter@. For example, for the parameter energy and Sentaurus Process syntax,
type:

implant Arsenic dose=1e+15 energy=@energy@ tilt=0 rot=0

Save the file.

5. Click Next.

6. Specify the parameter values of each parameter on the respective tabs: 

a) Select the minimal value of the parameter.

b) Select the iteration step between parameter values.

c) Select the number of parameter values.
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d) If the Linear option is selected, the difference between the values is equal to the
iteration step. If the Log option is selected, the value of each step is equal to the value
of the previous step multiplied by the value of the iteration step. 

7. Click Next.

8. Select a calibration parameter file for the process simulator of the parameterized process
file:

• Under Calibration, select the implantation model, and select the diffusion model.

• Select either the parameters of Advanced Calibration or User Calibration, in which
case, select up to two calibration files in the Alagator (Tcl) syntax of Sentaurus Process,
which usually follow the naming scheme *.fps.

9. Click Next.

10. Select the device simulation to calculate the sheet resistance from one of the following
options:

• Device Simulation Disabled (default)

• Device Simulation Enabled 

If this option is selected, the Sentaurus Mesh and Sentaurus Device tool instances are
part of the project. Click the Browse button to select the parameter file for Sentaurus
Device. The file format usually follows the naming convention *.par and is named
sdevice.par in the project. If no file is selected, Sentaurus Device uses the default
parameters.

11. Click Next.

12. Select an Optimizer task and the corresponding task conditions, if required, from the
following options:

• None 

• Sentaurus PCM Studio 

• Screening 

• Optimization 

• Iterative Optimization 

• Generic Optimization 

13. Click Next.

14. Select the methodology for the simulation and the experiment profile comparison from the
following options.
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For numeric comparison, select one of the following options:

• Relative Logarithmic Square Difference (default)

• Relative Linear Square Difference 

• Arithmetic Mean of Relative Error 

• Quadratic Mean of Relative Error 

The options of the Noise Filter field are deactivated by default. Select the options as
required to activate the noise filter (spline-based curve-smoothing) for experiment data, or
simulation data, or both.

Select the visualization tool. Sentaurus Visual is the default.

15. Click Next.

16. Select a project and scenario name:

a) Type a scenario name.

b) Click Browse to select a project directory, or type the project name.

17. Click Finish.

18. If the project is created and loaded successfully, click OK in the Progress dialog box.

If no Optimizer task is selected (Task Type is set to None), the new project has the structure
of a Calibration Kit project with two to seven parameters, that is, the parameter nr and the
selected parameters. The variable process is the selected process name combined with the
parameter value. The variable process_info contains the parameter name and value. The
values of the variables profile_@integer@ consist of the process name process and
sequential numbering, for example, <process>_1.

The project contains as many experiments as there are possible combinations of parameter
values.

If an Optimizer task is selected, the new project has the structure of a Calibration Kit project
with two to seven parameters, that is, the parameter nr is a user-defined Optimizer parameter
and the selected parameters are design-of-experiments (DoE) Optimizer parameters.

The only available variables are the process name process, the calibration file
calibration, and the number of profiles per process n_profile. The project contains only
one experiment with the mean parameter values. For each pair of profiles, a unique curve
comparison variable cv_delta_@integer@_@integer@ is evaluated and is used as a
response for the Optimizer tool. The corresponding command file of Optimizer is included in
the project. 

For information about the Optimizer tool, see the Optimizer User Guide.
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Creating a New Project for Optimization

You can create a new Calibration Kit project with new calibration parameters of Sentaurus
Process, and an optional command file of the Optimizer tool.

To create a new Calibration Kit project with new calibration parameters of Sentaurus Process:

1. Choose Calibration > Optimization Wizard.

The Optimization Wizard opens.

2. Click Next to start.

3. Select the calibration library database from either:

• Calibration Library, which is the experiment database of the Calibration Library in
Ligament SPR syntax.

• User Library, which is a user-specified database in either Ligament SPR syntax or
Sentaurus Process syntax.

If you select this option, you must specify the process directory, the experiment
directory, and the preference directory, and select the syntax from either Ligament,
Sentaurus Process, or TSUPREM-4.

4. Click Next.

5. Select a process list in one of the following ways:

• Under DBPS - Database Process Search, type a search pattern in the Process Search
Pattern field to look for processes using the DBPS in the selected database and syntax
(Step 3).

Select the alphabetic order of the process list file from either Process Names or
Process Recipes.

Click the Search button to write the results to the selected process list file (see
Database Process Search on page 32).

• Click the Browse button to select a list or search for a list using the DBPS. (For the
syntax of a process list file file.qps, see Process Searches on page 31.)

Click the Edit button to edit the selected list using the SEdit text editor.

6. Click Next.

7. Select the process simulator and calibration from either:

• Sentaurus Process (default)

If you choose this option, under Calibration, select the implantation model, and select
the diffusion model.
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Select either the parameters of Advanced Calibration or User Calibration, in which
case, select up to two calibration files in the Alagator (Tcl) syntax of Sentaurus Process,
which usually follow the naming scheme *.fps.

• TSUPREM-4 

If you choose this option, under Calibration, select the implantation model.

Select either the parameters of Advanced Calibration or User Calibration, in which
case, select the calibration files.

8. Click Next.

9. Parameterize the selected calibration file by entering the values of the fields for the
parameters:

NOTE For Sentaurus Process, only the second selected calibration file can be
parameterized.

a) Select up to four parameter names for parameter (for example, ifactor).

b) Select the minimal value and the maximal value of a parameter.

c) Select either the Linear option or the Logarithmic option.

d) Click Edit to load the calibration file into an editor.

Edit the file by replacing the calibration parameter values to be parameterized with
Sentaurus Workbench parameter calls @parameter@. (This calibration file will be
preprocessed by Sentaurus Workbench as well.)

Save the file.

10. Click Next.

11. Select an Optimizer task and the corresponding task conditions, if required, from the
following options:

• None 

If this option is selected, no Optimizer task is used, but you must select the number of
different parameter values for each parameter.

• Sentaurus PCM Studio 

If this option is selected, no Optimizer task is used, but you can add more parameter
values after the creation of the project.

• Screening 

• Optimization 
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• Iterative Optimization 

• Generic Optimization 

In addition, the project has a convenient structure for exporting the project view and
profiles to Sentaurus PCM Studio. For all other task types, a project with the corresponding
Optimizer command file is generated. (For information about Optimizer tasks, see the
Optimizer User Guide.) 

12. Click Next.

13. Select the device simulation to calculate the sheet resistance from one of the following
options:

• Device Simulation Disabled (default)

• Device Simulation Enabled 

If this option is selected, the Sentaurus Mesh and Sentaurus Device tool instances are
part of the project. Click the Browse button to select the parameter file for Sentaurus
Device. The file format usually follows the naming convention *.par and is named
sdevice.par in the project. If no file is selected, Sentaurus Device uses the default
parameters.
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14. Click Next.

15. Select the methodology for the simulation and the experiment profile comparison from the
following options:

For numeric comparison, select one of the following options:

• Relative Logarithmic Square Difference (default)

• Relative Linear Square Difference 

• Arithmetic Mean of Relative Error 

• Quadratic Mean of Relative Error 

The options of the Noise Filter field are deactivated by default. Select the options as
required to activate the noise filter (spline-based curve-smoothing) for experiment data, or
simulation data, or both.

Select the visualization tool. Sentaurus Visual is the default.

16. Click Next.

17. Select a project and scenario name:

a) Type a scenario name.

b) Click Browse to select a project directory, or type the project name.

18. Click Finish.

19. If the project is created and loaded successfully, click OK in the Progress dialog box.

If no Optimizer task is selected (Task Type is set to None), the new project has the structure
of a Calibration Kit project with two to seven parameters, that is, the parameter nr and the
selected parameters. For each process in the process list and each parameter value combination,
the Optimization Wizard creates an experiment that follows the file-naming convention of the
Calibration Kit.

In the case of a database in Ligament SPR syntax, the process is translated to the selected
process simulator syntax (see Process File Syntax on page 29). In the case of a database in
Sentaurus Process syntax, the process is copied; it is not translated. For Sentaurus Process, the
resulting process file is b@nr@_fps.cmd.

If an Optimizer task is selected, the new project has the structure of a Calibration Kit project
with two to seven parameters, that is, the parameter nr is a user-defined Optimizer parameter
and the selected parameters are DoE Optimizer parameters.

The only available variables are the process name process, the calibration file
calibration, and the number of profiles per process n_profile. The project contains only
one experiment per process in the process list with mean parameter values. For each pair of
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profiles, a unique curve comparison variable cv_delta_@integer@_@integer@ is
evaluated and is used as a response for Optimizer. The corresponding command file of
Optimizer is included in the project.

For information about the Optimizer tool, see the Optimizer User Guide.

Editing Variables

You can change the variable values of a Calibration Kit experiment using Sentaurus
Workbench.

To edit a variable:

1. Select the corresponding node:

• This is the second Sentaurus Process node for the variables process, calibration,
process_info, Rs_exp, n_profile, and profile_@integer@ (where integer
is equal to 1, 2, 3, ..., 10).

• This is the Sentaurus Mesh node for the variables *_contact and *_sheet.

2. Edit the variable values in one of the following ways:

• Choose Nodes > Set Variable Value.

The Add Variable to Node dialog box is displayed.

Enter the name and the value of the variable, and click OK.

• Choose Nodes > Edit Properties.

The Node information dialog box is displayed.

Under Defined Variables, edit the definition of the variable (as shown in the following
example), and click OK. 
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Visualizing Project Files

Each Calibration Kit project has dedicated viewers that are defined in the project tool database
(gtooldb.tcl) of Sentaurus Workbench. These viewers are specifically for the files of
Calibration Kit projects. 

Figure 3 Specific viewers of files of Calibration Kit projects available from the visualization 
toolbar button

Viewing Process Files

To view process files:

■ Choose the  button > Calibration Process Files (SEdit).

These files open in the SEdit text editor. For Sentaurus Process, the process files are the
Sentaurus Process command files (b@node@_fps.cmd or pp@node@_fps.cmd) and general
files (*.fps). The selection is restricted to the nr nodes of Sentaurus Process.
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Viewing Profile Files

To view profile files:

■ Choose the  button > Calibration Profile Files (Inspect).

The selected measured profiles (b@node@_*.plx) and simulated profiles (b@node@_*.plt)
open in Inspect. All of the selected profiles are loaded into one xy plot. The selection is
restricted to the nr nodes of Sentaurus Process. 

Figure 4 An experiment visualized in Inspect

Viewing Visualization Files

To view visualization files:

■ Choose the  button > Calibration Visual Files (SVisual).

The selected measured profiles (b@node@_*.plx) and the simulated profiles
(b@node@_*.plt) open in Sentaurus Visual. All of the selected xy plot visualization scripts
(n@node@_vis_out.tcl) are loaded and arranged next to each other. The selection is
restricted to Sentaurus Visual nodes. For more information, see the Sentaurus™ Visual User
Guide.
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Figure 5 Four experiments visualized in Sentaurus Visual

Confidentiality Warning

The file $STROOT/tcad/$STRELEASE/lib/fabpackagelib/confidentwarning.txt
contains the text for the confidentiality warning that appears on the first page of the Project
Wizard, Scenario Wizard, and Optimization Wizard. If the file is empty or does not exist, no
confidentiality warning is displayed.

The file $STCALIB/confident.txt contains the text for the confidentiality warning that
appears in a separate dialog box when the third page of the Project Wizard and Optimization
Wizard is displayed. If the file is empty or does not exist, no confidentiality warning is
displayed.
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Searches, and Profiles

This chapter provides details about the Calibration Library, process
searches, and working with profiles.

Experiment Database: Calibration Library

This section describes the Calibration Library of the Calibration Kit.

Defining the Calibration Library

The default experiment database of the Calibration Kit – the Calibration Library – is defined
using the system environment variable STCALIB. By default, STCALIB is set to the directory
$STROOT_LIB/fabpackagelib, which contains a database including process examples for
demonstration purpose only and without any real experimental relevance.

The STCALIB databases (such as the Calibration Library or user databases) include three
directories:

■ The process directory, which is either processes_lig containing the process files in
Ligament SPR syntax, or processes_sprocess containing the process files in Sentaurus
Process syntax.

■ The experiment directory experiments contains the SIMS profile files in xy plot format.

■ The preference directory preferences contains the preference files (see Profiles on
page 34).

Process File Syntax

In general, the Calibration Kit uses databases of process recipes in Ligament SPR syntax and
Sentaurus Process syntax as input. However, the process recipes of the Calibration Library are
delivered in Ligament SPR syntax and are translated to Sentaurus Process syntax before
simulation.
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For the Calibration Library (as well as other user databases) to be input to the Calibration Kit,
the general Ligament SPR syntax and Sentaurus Process syntax are subject to restrictions.

Restrictions on Ligament SPR Syntax

During the creation of a Calibration Kit project, the process recipes in Ligament SPR syntax
are translated to Sentaurus Process syntax. First, the translator of the Calibration Kit uses the
Ligament Translator. Then, some process flow translations specific to the Calibration Kit are
applied (see Restrictions on Sentaurus Process Syntax).

In Ligament process flows, the arguments save, grid, debug, and check1d of the
environment statement must all be set to false. The arguments title, region, and
*_grid_* of the environment statement are irrelevant, since they are ignored during
translation.

The 1D measurements are stated in an insert statement.

For Sentaurus Process, the 1D measurement statement is specified by the SetPltList
statement, which is defined in calib_1d_*.fps. The SetPltList statement must only
contain the species variable and a comment of the corresponding SIMS profile at the end of
the same line (see Restrictions on Sentaurus Process Syntax).

For Sentaurus Process, the 1D profile load statement is specified by the profile statement,
which must only contain the species variable and a comment of the corresponding profile at
the end of the same line (see Restrictions on Sentaurus Process Syntax).

The process information <INFO> can be declared in a remark statement with processinfo
'<INFO>' as text.

The measured sheet resistance value <VALUE> can be declared in a remark statement with
sheetresistance 'Rs=<VALUE>' as text.

The measured cap-oxide thickness value <VALUE> in [nm] can be declared in a remark
statement with OxideThickness <VALUE> as text.

Restrictions on Sentaurus Process Syntax

The process recipes in Sentaurus Process syntax in the database must include only process
physics parameters. However, if you include simulator or model parameters in the process
recipe files, the reliability of the simulation might be reduced.

The Sentaurus Process recipes must not contain line statements or region statements (the
sourced file calib_1d_2017.09.fps or calib_KMC_2017.09.fps places these
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statements in the input files of Sentaurus Process). During translation from Ligament SPR
syntax to Sentaurus Process syntax, all statements preceding the first init statement are
removed.

The 1D measurement statement is specified by the SetPltList statement, which is defined
in calib_1d_2017.09.fps or calib_KMC_2017.09.fps. The SetPltList statement
must contain only the species variable and a comment of the corresponding SIMS profile at
the end of the same line, for example:

SetPltList BTotal ; # B_sims_profile.sims

The 1D profile load statement is specified by the profile statement, which must contain only
the species variable and a comment of the corresponding profile at the end of the same line,
for example:

profile name=Boron ; # B_sims_profile.sims

The process information <INFO> can be declared in a comment line with processinfo
"<INFO>" as comment, for example:

## processinfo "B 0.5keV 1e15"

The measured sheet resistance value <VALUE> can be declared in a comment line with
sheetresistance "Rs=<VALUE>" as a comment, for example:

## sheetresistance "Rs=491"

The measured cap-oxide thickness value <VALUE> in [nm] can be declared in a comment line
with OxideThickness <VALUE> as comment.

Process Searches

The module Quick Process Search (QPS) provides basic functionality for the process search in
the process directory of the database. The Database Process Search (DBPS) module and the
Calibration Project Process Search (CPPS) module are based on QPS.

Syntax of the QPS List File

The results of DBPS and CPPS as well as the input process list to the Calibration Kit project
and the scenario wizards are QPS files file.qps. The file contains a header line and a process
list.
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The syntax is:

Processes Profiles Processinfo R_sheet 
<process> <profile_1> <info> <r_sheet>

<profile_2>

Database Process Search

The Database Process Search (DBPS) looks for process flows written in the syntax of Ligament
or Sentaurus Process in a directory (such as $STCALIB/processes_*). The processes that
match the search criterion are listed in the process list file.

The search criterion – the process search pattern – consists of conditions connected by logical
operators &&, ||, !, and grouped by parentheses. The operator && means and, || means or,
and ! means not. The conditions consist of a keyword and arguments, for example,
impl(element==As) or nimpl>0.

In general, the keyword takes only one argument. Only the impl() and diff() keywords can
have more than one argument that are connected by logical operators. Some arguments consist
of an argument type and a value connected by comparators: ==, <=, >=, <, >, or !=. Some
arguments do not have comparators or argument types.

Table 1 lists the DBPS process flow keywords and their syntax, which are allowed in the DBPS
criterion.

Table 1 DBPS keywords and syntax

Keyword Meaning Argument Example

impl() Implantation statement scan, 
true if (1)

element, elem
energy, en
dose
tilt
rotation, rot

impl(elem==as)
impl(en>0 && en<100)
impl(dose>=1e12)
impl(tilt!=0)
impl(rot<1)

diff() Diffusion statement scan, true 
if (1)

maxT (maximum temperature)
totaltime
peaktime (time at maximum 
temperature)
pn2 (partial pressure for N2)
po2 (partial pressure for O2)
ph2o (partial pressure for H2O)

diff(maxT==1000)
diff(totaltime>5)
diff(peaktime!=0)

diff(pn2==1)
diff(po2>0 && po2<1)
diff(ph2o!=0)

plot() Plot statement scan, true if (2) X, Xtot, Xtotal, Xactive
(where X is one of as, p, b, in, ge, 
sb, ga, al, n)

plot(bactive)

nimpl Number of implantation 
statements scan, true if (3)

– nimpl==1
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Calibration Project Process Search

The Calibration Project Process Search (CPPS) looks for experiments in a calibration project
of Sentaurus Workbench. The tool scans process flows written in the syntax of Sentaurus
Process in the same way as DBPS. However, CPPS scans variables of the Sentaurus
Workbench. The experiments that match the search criterion are listed in the process list file.

The search criterion – the process search pattern – consists of conditions connected by logical
operators &&, ||, !, and grouped by parentheses. The operator && means and, || means or,
and ! means not. The conditions consist of a keyword and arguments, for example,
impl(element==As) or nimpl>0.

In general, the keyword takes only one argument. Only the impl() and diff() keywords can
have more than one argument that are connected by logical operators. Some arguments consist
of an argument type and a value connected by comparators: ==, <=, >=, <, >, or !=. Some
arguments do not have comparators or argument types.

Table 2 lists the DBPS process flow keywords and their syntax, which are allowed in the CPPS
criterion. 

ndiff Number of diffusion 
statement scan, true if (3)

– ndiff>0

file() File name scan, true if (2) <string> file(USJ)

grep() Process file scan, true if (2) <string> grep(comment)

(1) At least one statement exists in the process file, for which the arguments are evaluated as true.
(2) At least one statement exists in the process file, for which the argument is evaluated as true.
(3) Comparison is evaluated as true.

Table 2 Keywords and syntax for CPPS of DBPS

Keyword Meaning Argument Example

impl() Implantation statement scan, 
true if (1)

element, elem
energy, en
dose
tilt
rotation, rot

impl(elem==as)
impl(en>0 && en<100)
impl(dose>=1e12)
impl(tilt!=0)
impl(rot<1)

Table 1 DBPS keywords and syntax

Keyword Meaning Argument Example
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Table 3 lists the Sentaurus Workbench variable keyword and its syntax, which is allowed in the
search criterion.

Profiles

This section discusses different aspects of profiles.

Visualizing Profiles

The visualization limits of each profile can be set in the preference file. The depth [nm] is set
by:

set vis_xmin [integer]
set vis_xmax [integer]

diff() Diffusion statement scan, true 
if (1)

maxT (maximum temperature)
totaltime
peaktime (time at maximum 
temperature)
pn2 (partial pressure for N2)
po2 (partial pressure for O2)
ph2o (partial pressure for H2O)

diff(maxT==1000)
diff(totaltime>5)
diff(peaktime!=0)

diff(pn2==1)
diff(po2>0 && po2<1)
diff(ph2o!=0)

plot() Plot statement scan, true if (2) X, Xtot, Xtotal, Xactive
(where X is one of as, p, b, in, ge, 
sb, ga, al, n)

plot(bactive)

nimpl Number of implantation 
statements scan, true if (3)

– nimpl==1

ndiff Number of diffusion 
statement scan, true if (3)

– ndiff>0

grep() Process file scan, true if (2) <string> grep(comment)

(1) At least one statement exists in the process file, for which the arguments are evaluated as true.
(2) At least one statement exists in the process file, for which the argument is evaluated as true.
(3) Comparison is evaluated as true.

Table 3 Keywords and syntax for CPPS of Sentaurus Workbench variable

Keyword Meaning Argument Example

process() Process variable scan, true if at least one statement exists in the 
process file, for which the arguments are evaluated as true

<string> process(USJ)

Table 2 Keywords and syntax for CPPS of DBPS

Keyword Meaning Argument Example
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The concentration [ ] is set by:

set vis_ymin [integer]
set vis_ymax [integer]

These values are the lower and upper limits of the visualization to be shown. A limit is
evaluated by the visualization tool if the corresponding limit is not present in the preference
file.

Comparing Profile Curves

Inspect calculates the differences of the measured and computed profile curves, which can be
viewed in the Inspect log file. Optionally, the noise of the profile curves can be filtered by
spline-based curve-smoothing. The difference is processed as the variable
cv_delta_@integer@ of Sentaurus Workbench for each profile pair.

The quality limits of each profile can be set in the preference file. The depth [nm] is set by:

set sims_xmin [integer]
set sims_xmax [integer]

These values are the lower and upper limits of the profile curve comparison. The default limits
are used as borders if the above limits are not defined. The default values are:

set sims_xmin 5
set sims_xmax 50

The minimal and maximal concentrations [ ] are set by:

set sims_ymin [double]
set sims_ymax [double]

Concentrations outside of this range are set to the corresponding border value of the profile
curve comparison. The default limits are used as borders if the above limits are not defined. By
default, sims_ymin is half the concentration of the smoothed experiment profile curve at the
depth sims_xmax, while the default for sims_ymax is 1e23.

NOTE If several profile pairs are visualized in one plot, only the comparison
borders of the last profile pair are shown.

cm 3–

cm 3–
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The profile curve comparison can be performed using different methodologies:

■ Relative logarithmic square difference

■ Relative linear square difference

■ Arithmetic mean of relative error

■ Quadratic mean of relative error

Relative Logarithmic Square Difference

The formula for the relative logarithmic square difference for the experiment profile curve 
and the simulated profile curve  is:

(1)

where the borders of integration  and  are the lower and upper limits of the profile
curve comparison, respectively. The relative logarithmic square difference is set per depth
[ ].

Relative Linear Square Difference

The formula for the relative linear square difference for the experiment profile curve  and
the simulated profile curve  is:

(2)

where the borders of integration  and  are the lower and upper limits of the profile
curve comparison, respectively. The relative linear square difference is set per depth [ ].

Arithmetic Mean of Relative Error

The formula for the arithmetic mean of the relative error for the experiment profile curve 
and the simulated profile curve  is:

(3)
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where the borders of integration  and  are the lower and upper limits of the profile
curve comparison, respectively. For each measurement point,  results in 1, or else in 0.

Quadratic Mean of Relative Error

The formula for the quadratic mean (or root-mean-square) of the relative error for the
experiment profile curve  and the simulated profile curve  is:

(4)

where the borders of integration  and  are the lower and upper limits of the profile
curve comparison, respectively. For each measurement point,  results in 1, or else in 0.

xmin xmax
P x( )

fe fs

P x( ) fe x( ) fs x( )–
fe x( )

------------------------------
2

xd

xmin

xmax



P x( ) xd

xmin

xmax



------------------------------------------------------------------

xmin xmax
P x( )
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